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1 Introduction

This version of Mimic contains several new features and enhancements.

For more information about each feature discussed in this manual, open the online Help and
refer to the "What's New in this Version" topic. Links are provided in each new feature
description, taking you to topics that contain additional information and steps.

This chapter discusses the following:

Summary of Major New Features 6
Summary of Additional New Features 8
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Summary of Major New Features
Following are themajor new features introduced in this version of Mimic.

MAJOR NEW FEATURES

Feature What's New? For More Information

Frame Editor Enhance-
ments

Integrated live preview with synchronized
audio

Centered frames

Reorganized toolbar options

See "Frame Editor
Enhancements" on
page 11.

Keyframes Trajectories and existing animation features
converted to keyframes

New animation features available through
keyframes

See "Keyframes" on
page 17.

Linking to External
Palettes

Share palettes with other teammembers See "Linking to
External Palettes" on
page 49.

Properties Window
Pane

A single window pane to control properties
for objects

Replaces object property dialogs

See "Properties Win-
dow Pane" on page 51.

Timeline Enhance-
ments

Control keyframes in timeline

View for single frame or entire movie

Scrubber synchronized with live preview
playback; lets youmove to specific time in
frame ormovie

See "Timeline Enhance-
ments" on page 57.

Video Insertion Ability to insert WMV orMP4 videos as new
frames in amovie

See "Video Insertion"
on page 67.



CHAPTER 1│What's NewGuide 7

MAJOR NEW FEATURES

Feature What's New? For More Information

Video Services
(YouTube and Vimeo
Upload)

Video Services window pane

Upload non-interactive HTML5 outputs to
YouTube or Vimeo

See "Video Services"
on page 69.

Visual States Visual States window pane

Createmultiple states for an object's appear-
ance

Assign a state using the object's action prop-
erties

See "Visual States" on
page 77.
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Summary of Additional New Features
Following are several additional new features and enhancements introduced this version of Mimic.

ADDITIONAL NEW FEATURES

Feature What's New? For More Information

Auto-Size
Objects to Fit
Text

Automatically adjust the width and height of an
object to fit any text inside

See "Auto-Size Objects
to Fit Text" on page 90.

Clipping Hide part of an object or an entire frame See "Clipping" on page
92.

Cursor Tra-
jectories

Position keyframes to change a cursor's location
and timing

See "Cursor Tra-
jectories" on page 96.

Dictionaries—
Importing

Use theOptions dialog to import dictionaries
downloaded from OpenOffice.org.

View all installed dictionaries on the Spelling tab

See "Dictionaries—
Importing" on page 100.

FIPS Compliance Mimic uses cryptographic modules that are com-
pliant with the Federal Information Processing
Standard (FIPS)

See "FIPS Compliance"
on page 102.

Font Enhance-
ments

Pinning fonts

Font groups

See "Font Enhance-
ments" on page 103.

Object Prop-
erties—Apply to
All

Apply properties to all of the objects in the work-
space at once

See "Object Prop-
erties—Apply to All" on
page 107.

Object Rotation Click and drag to rotate

Control object's rotation without having to use
predetermined settings

See "Object Rotation" on
page 109.

http://www.openoffice.org/
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ADDITIONAL NEW FEATURES

Feature What's New? For More Information

Preview Mode Use Frame Editor to view an action set on an
object

Preview frames without buildingmovie output

See "Preview Mode" on
page 110.

Ribbons
Redesigned

Object and Edit ribbons combined to create
Home ribbon

Objects and effects grouped together in amore
intuitive way

See "Ribbons
Redesigned" on page
111.

Start Page
Redesigned

Major redesign

Pin recent files

See "Start Page
Redesigned" on page
112.



10



C
HA

PT
ER

2 Frame Editor Enhancements

There have beenmajor changes to the Frame Editor in Mimic. These include integrated live
preview, centered frames, and a reorganized toolbar.

This chapter discusses the following:

Integrated Live Preview with Synchronized Audio 12
Centered Frames 14
Reorganized Toolbar Options 15
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Integrated Live Previewwith Synchronized Audio
In previous versions, a separate window opened when you previewed amovie or part of it. This has been
replaced by an integrated play bar and buttons that allow you to review any part of a frame ormovie, view-
ing it directly in the Frame Editor.

You can click the play button to play back the frame ormovie from the selected spot. You can also click
and drag the playhead, whichmoves through the video (also called "scrubbing").

There are some new elements in the revamped Timeline window pane that work in conjunction with the
integrated live preview. When you press the play button while using the Timeline's Frame View option, only
the frame that is currently open in the Frame Editor will be played. Switching to the Timeline's Movie View
option lets you preview the entire movie.

Finally, you will notice that the audio associated with themovie or frame is now synchronized with the pre-
view.
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E X A M P L E

Let's say you have anMP4 associated with the entire movie. In previous versions, if you began pre-
viewing at frame 25, the audio would begin playing from the beginning of the audio, which was
meant for frame 1. Starting with this version, if you begin previewing at frame 25, the audio con-
nected to that part of themovie is what plays in the preview playback.
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Centered Frames
The Frame Editor has been updated so that the frames you are editing are centered within it. Previously,
they were aligned to the top-left of the editor.

Mimic 7

Mimic 8
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Reorganized Toolbar Options
The options seen in the top or bottom local toolbar of the Frame Editor have changed.

The preview controls are located at the bottom of the editor in the form of a playhead. In addition to the play
button, there are back and forward buttons that let you skip to the previous or next frame of themovie,
respectively. These replace the navigation buttons that previously were found in the top toolbar.

Object and object appearance shortcuts have beenmoved under the Objects and Effects drop-downs, and
the options previously found in the bottom toolbar have beenmoved to the top toolbar.
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3 Keyframes

Keyframes indicate points within a framewhere an object or clip effect will transition from its
current state to a new state. In other words, whenever a keyframe transition happens, the
object or clip effect properties change. Because of this, you can create simple animations,
such as a "bouncing" oval.

This chapter discusses the following:

How to Create Object Keyframes 28
How to Edit Object Keyframes 36
How toMove Keyframes 43
How to Remove Keyframes 45
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You can tell that an object or clip effect contains keyframes by looking in the Frame View and Action View
options in the Timeline window pane. If a keyframe type bar containing one or more diamonds is nested
below an object or a clip effect, it contains keyframes. See "Keyframes" on the previous page.

Additionally, when you add an object that contains keyframes to a palette, it retains the keyframes. If that
object has a clip effect applied to it and that clip effect contains keyframes, they will also carry over to the
palette.

Depending on the object you have selected, keyframes allow many transitions, including:

Background The object's background color changes.

Opacity The object's transparency changes.

Position The object or effect areamoves directionally on the frame.

Size The object or effect area can become larger or smaller.

Rotation The object rotates, in any direction, on the frame.

Text Text on the object changes, including what is actually typed, font type, font formatting, and the
position of the text on the object.

Note: You can add size and position keyframes to clip effects. Clip is the only effect that supports
keyframes. Note that the opacity keyframe (which can be applied to any object) is not the same
as an opacity effect (which can only be applied to image objects).
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E X A M P L E

This frame contains a black rectangle object. Right now, the object is opaque. However, we want it
to change between black and white during the course of the frame. To do this, we will add a series
of background keyframes by using the Keyframe button in the Object Properties window pane.

When the object is at the starting point of the transition—in other words, when we first want the
object to change color—click the keyframe button next to the Color property in the Object Properties
window pane. Once the first keyframe has been added, the background keyframe type bar is added
to the object. Each keyframe is indicated by diamond on the keyframe type bar.
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For each new color setting, drag the playhead to the time at which the object should change color,
then select a new color from theObject Appearance section in the Object Properties window pane.
A new keyframe diamond is automatically added to the Timeline.
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Additionally, you can set an interpolation option when creating keyframes. This changes the type of
transition between each keyframe. To do this, click the keyframe diamond, then select an option
from the Interpolation drop-down in the Keyframe Properties window pane. In this case, you can
pick linear or discrete interpolation. A linear interpolation causes a gradual fade between each color,
while a discrete interpolation causes a distinct change between the colors precisely when the key-
frame is reached.
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E X A M P L E

This frame contains an oval object to which a clip effect has been applied. Right now, the effect cov-
ers the entire object, so you can see the entire oval. However, we want the effect to gradually move
off the oval, so the oval disappears from the frame. To do this, we can add a series of position key-
frames by using the Keyframe button in the Effect Properties window pane.
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When the object is at the starting point of the effect, in other words, when the entire oval is con-
tained in the clip effect area rectangle, click the position keyframe button. Once the first keyframe
has been added, the position keyframe type bar is added to the clip effect bar, and each keyframe is
indicated by diamond on the keyframe type bar. Additionally, a blue trajectory dot is added to the
frame to indicate the current location of the effect.
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For each position, drag the playhead to the time at which the effect shouldmove, then drag the
effect rectangle to the right of the oval. A new keyframe diamond is automatically added to the
Timeline, and the trajectory updates.
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Continue to add position keyframes until the entire oval has disappeared.
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How to Create Object Keyframes
Whenever you add an object to a frame, you have the option to set up keyframes. Additionally, you can set
some types of keyframes on clip effects that have been applied to objects. When viewing the Object or
Effect Properties window pane, object and clip effect attributes (e.g., size, position) that can include key-
frames are indicated by a yellow diamond button . Objects and clip effects can includemore than one
keyframe type.

1. Open amovie that contains objects, or add an object to a frame.

2. Click the object.

3. Select theObject ribbon. From theAdvanced section, select Properties.

TheObject Properties window pane opens.

4. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to objects will
also be in this view.

For action object types, click Action View. Any objects converted to action objects will also
be in this view.

5. Add one of the following keyframe types:

OBJECT OPACITY

Altering the object opacity within keyframes canmake an object appear to fade in or out of a frame.

a. In the Object Properties window pane, expand theObject Appearance section.

b. Drag theOpacity slider to the level of transparency that you want the object to start at. For
example, if you pick 100%, the object will start out with a completely opaque look.

c. From beside theOpacity slider, click .

In the Timeline, an opacity keyframe bar will nest under the object.

d. In the Timeline, drag the playhead to the point of time when the first opacity transition should
begin.
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e. Drag theOpacity slider to the desired percentage.

Once you select the desired opacity, a new keyframewill automatically appear in the opacity
keyframe bar. You do not need to click again.

f. (Optional) Repeat steps d and e as needed.

Tip: If you want to make an object gradually go from 0-100% opacity (or the other way
around), you really only have to set two keyframes. Set the first one at the beginning of the
object, then set the final state at the very end of the object. The object is automatically set
to have a linear interpolation, so the transition will happen gradually over the duration of the
object's time span.

OBJECT COLOR

A timed, subtle change to an object's color can redirect attention to that object when the transition
begins.

a. In the Object Properties window pane, expand theObject Appearance section.

b. In theBackground section, set the starting color (solid will have one color field, gradient will
have two) for the object. To see advanced color options, select . You can also click to
pick a color from your screen.

c. From beside the color field (first color field if you are using a gradient), click .

In the Timeline, a background keyframe bar will nest under the object.

d. In the Timeline, drag the playhead to the point of time when the first color transition should
begin.

e. In theBackground section, set the next color (solid will have one color field, gradient will
have two) for the object.

Once you select the desired color, a new keyframewill automatically appear in the back-
ground keyframe bar. You do not need to click again.

f. (Optional) Repeat steps d and e to addmore background color keyframes.
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Tip: If you want a gradient to display for one or more keyframes but want a solid color for
the rest of the object's keyframes, choose one of the gradient background types for the
object. For the keyframes you want to remain solid, pick the same color for both gradient
fields.

OBJECT POSITION

Trajectories created by using position keyframes to change an object's position have replaced the
way Mimic 7 handled trajectories. When you create keyframes in order to move the position of an
object, a trajectory is automatically shown in the Frame Editor. Eachmovement point is indicated by
a blue circle on the trajectory's dotted line.

a. In the Object Properties window pane, expand theObject Layout section.

b. Manually set the starting position of the object by dragging it to the desired location in the
Frame Editor, or set it using the Position fields in the Object Properties window pane:

i. In the first Position field, select the starting horizontal position for the object.
Increase the number tomove the object to the right, or decrease the number tomove
the object to the left.

ii. In the secondPosition field, select the starting vertical position for the object.
increase the number tomove the object down, or decrease the number tomove the
object up.

c. From beside thePosition fields, click .

In the Timeline, a position keyframe bar will nest under the object. Additionally, a small blue
circle will appear beside the object in the Frame Editor. As you add position keyframes, these
circles will represent each new position, and a dotted path will form between them, showing
you the object motion.

d. In the Timeline, drag the playhead to the point of time when the first position transition should
begin.
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e. Manually set the starting position of the object by dragging it to the desired location in the
Frame Editor, or set it using the Position fields in the Object Properties window pane:

i. In the first Position field, select the next horizontal position for the object. Increase
the number tomove the object to the right, or decrease the number tomove the object
to the left.

ii. In the secondPosition field, select the next vertical position for the object. increase
the number tomove the object down, or decrease the number tomove the object up.

Once you set one of the positions, a new keyframewill automatically appear in the
position keyframe bar. You do not need to click again.

f. (Optional) Repeat step d and e to continue adding position keyframes.

OBJECT SIZE

Youmight want to show an object becoming smaller to accommodate other objects taking over the
focal point of the frame.

a. In the Object Properties window pane, expand theObject Layout section.

b. Manually set the starting size of the object by clicking and dragging the small blue handles on
the object, or set it using the Size fields in the Object Layout section:

i. In the first Size field, increase the number to add width, or decrease the number to
shrink the width to set the starting size of object.

ii. In the secondSize field, increase the number to add length, or decrease the number to
shorten the object to set the starting size of object.

c. From beside theSize fields, click .

In the Timeline, a size keyframe bar will nest under the object.

d. In the Timeline, drag the playhead to the point of time when the first size transition should
begin.
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e. Manually set the next size of the object by clicking and dragging the small blue handles
around the object, or set it using the Size fields in the Object Layout section:

i. In the first Size field, select the next width for the object.

ii. In the secondSize field, select the next height for the object.

Once you resize the object, a new keyframewill automatically appear in the size key-
frame bar. You do not need to click again.

f. (Optional) Repeat steps e-g to continue adding size keyframes.

Note: Size keyframes are not available for arrows, bubbles, polygons, and polylines.

OBJECT ROTATION

Rotating an object on the framewill create a spinning effect.

a. In the Object Properties window pane, expand theObject Layout section.

b. Rotate the object by clicking and dragging the large blue handle on the object, or by changing
the number in theRotation field to set the starting look for the object.

c. From beside theRotation field, click .

In the Timeline, the Rotation keyframe bar will nest under the object.

d. In the Timeline, drag the playhead to the point of time when the first rotation transition should
begin.

e. Rotate the object by clicking and dragging the large blue handle on the object, or by changing
the number in theRotation field.

Once you change the rotation, a new keyframewill automatically appear in the Rotation key-
frame bar. You do not need to click again.

f. (Optional) Repeat steps d and e to create adding rotation keyframes.
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OBJECT TEXT

Changing the text on an object allows you to reuse that object.

a. In the Object Properties window pane, expand the Text section.

b. Click on the object and start typing, or in the Text field, enter the starting text for the object.

c. From beside the Text field, click .

In the Timeline, the Text keyframe bar will nest under the object.

d. In the Timeline, drag the playhead to the point of time when the first text transition should
begin.

e. Click on the object and start typing, or in the Text field, enter the next text you want the
object to show.

Once you change the contents of the Text field, a new keyframewill automatically appear in
the Text keyframe bar. You do not need to click again.

f. (Optional) Repeat steps d and e to continue adding text keyframes.
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Tip:When applying position keyframes to an object or effect, the position keyframe loc-
ation is placed at the upper left corner of the object. Depending on the type of path you are
drawing, youmay want to slightly adjust the object's trajectory to account for the space
between the upper left corner of the object and themiddle of the object.

For example, if you have a cursor object and you need it to "click" a button, youmay want
to position the trajectory slightly above and to the left of the button, so it appears that the
cursor is in themiddle of the button.
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Tip: If you resize an object bar, the keyframes associated with that object do not auto-
matically adjust to reflect the object bar's new size. As a result, some keyframes may play
before or after the object's start or end time, and will not appear in the output. Remember to
check your keyframes when adjusting your object timing.

Note:When you are creating another keyframewithin the same object and keyframe type,
you do not need to click the keyframe button again. Any keyframes added after the first are
automatically created when the property is changed.

Note: All objects do not have the same keyframe options. For example, cursor objects do
not have a rotation property.

Note: You can copy an object that contains keyframes to a different frame, and the key-
frames will be retained. However, if the new frame is shorter than the original frame, some
keyframes may not be played (because they occur after the frame has ended). If you want
all of the keyframes to play, youmay need tomove them to fit within the duration of the
new frame.

Note: If you want to change the way the object transitions from one state to the next, you
will need to edit each keyframe.

6. Continue adding keyframes as needed.

7. Click to save your work.
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How to Edit Object Keyframes
Once you have set a keyframe, you can easily edit it. This is particularly useful when you only want to
makeminor adjustments to your existing keyframe.

E X A M P L E

Let's say you have an oval that goes from red to blue to yellow. You want to change the red state to
a light blue.
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When you click on the first diamond that represents the red state, the Keyframe Properties window
pane opens, showing only the Gradient Keyframe properties.

Once you set the value field to a light blue color, you can preview your movie or save your work.

1. Open amovie that contains one or more objects that have had keyframes applied.

2. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to objects will
also be in this view.

For action object types, click Action View. Any objects converted to action objects will also
be in this view.

3. Scroll down to the object's desired keyframe bar (e.g., opacity, text).

4. Click on the keyframe (diamond) within the keyframe bar that corresponds to the transition that you
want to edit. The Keyframe Properties window pane opens.

5. Do one of the following, depending on the type of keyframe:
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CHANGE THE OPACITY

a. In the Keyframe Properties window pane, expand theOpacity Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a different time at which the keyframewill begin.

ValueSelect a different percentage for the amount of opacity for this particular key-
frame.

Interpolation Select one of the following:

Linear Set a gradual change in opacity from this keyframe to the next.

Discrete Set an instant change in opacity from this keyframe to the next.

CHANGE THE COLOR

a. In the Keyframe Properties window pane, expand theGradient Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a different time at which the keyframewill begin.

GradientSelect a different color for the object for this particular keyframe. Click the
down arrow in the first field to select a color for the start of the gradient, or the second
field to select a color for the end of the gradient. If you want a solid color, set both
fields to the same color. To see advanced color options, select . You can also click

to pick a color from your screen.

Interpolation Select one of the following:

Linear Set a gradual change in color from this keyframe to the next.

Discrete Set an instant change in color from this keyframe to the next.
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CHANGE THE POSITION AND TRAJECTORY

You havemore options for the trajectory when editing a position keyframe. Edit a position keyframe
to change the way the trajectory moves from one keyframe to the next (e.g., curved path, straight
path, no path).

a. In the Keyframe Properties window pane, expand thePosition Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a different time for the keyframe to begin.

Position Select a different position on the frame for the object for this keyframe. The
first field sets the horizontal position, and the second sets the vertical position. You
can also drag a position keyframe's corresponding trajectory point in the Frame Editor
to move it the object to a new position. This changes the position numbers auto-
matically.

Interpolation Select one of the following:

Linear Set a straight path from this keyframe to the next.

Discrete Set an instant jump from this keyframe to the next. In other words, the
object will not move along a path; it will appear in one position, and then the next.

Bezier Set a curved path from this keyframe to the next. This opens two sets of
Control Point fields. The first control point set is for the length of the control; the
second field is for the position. This allows you to customize the depth of the tra-
jectory's arc (first field) and the position of the trajectory's wave (second field).
As an alternative to using the Control Point fields, you canmanually click and
drag the white control point handles in the Frame Editor to change the path's arc
and wave.

Control Point 1 Controls the trajectory from this keyframe to the previous
keyframe. This control will not work on the first position keyframe as this
keyframe is the starting point.

Control Point 2 Controls the trajectory between each keyframe.
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E X A M P L E

This rectangle has a linear trajectory. It will move smoothly along the
straight trajectory line.

This rectangle has a discrete trajectory. It will jump from one trajectory
point to the next.
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This rectangle has a bezier trajectory. It will move smoothly along a
curved line. You can adjust the control points (the white dots) to change
the shape of the curve between each keyframe.

CHANGE THE SIZE

Youmight want to show an object become smaller to accommodate other objects taking over the
focal point of the frame.

a. In the Keyframe Properties window pane, expand theSize Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a different time at which the keyframewill begin.

SizeSelect a different size for the object for this particular keyframe. The first field
sets the width, and the second field sets the height. Manually set the size of the
object for each keyframe by clicking and dragging the small blue handles on the
object.

Interpolation Select one of the following:

Linear Set a gradual change in size from this keyframe to the next.

Discrete Set an instant change in size from this keyframe to the next.
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CHANGE THE ROTATION

Rotating an object on the framewill create a spinning effect.

a. In the Keyframe Properties window pane, expand theRotation Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a time at which the keyframewill begin.

ValueSelect or enter a number for the amount of rotation. A negative number turns
the object counter-clockwise, while a positive number turns it clockwise. Manually
rotate the object by clicking and dragging the large blue handle on the object.

Interpolation Select one of the following:

Linear Set a gradual change in rotation from this keyframe and the next.

Discrete Set an instant change in rotation from this keyframe to the next.

CHANGE THE TEXT

Changing the text on an object allows you to reuse that object.

a. In the Keyframe Properties window pane, expand the Text Keyframe section.

b. In theProperties section, do one of the following:

TimeSelect a different time at which the keyframewill begin.

Text In the text box, enter the text that will appear during the keyframe.

Interpolation The interpolation between text keyframes is always discrete. One key-
frame's text is completely removed before the next keyframe's text appears on the
object. This prevents an overlapping of text between keyframes.

Note: Each diamond within an object's keyframe type bar (e.g., the Opacity bar) is treated
separately. In other words, if an Opacity bar shows five diamonds, each of those diamonds
represents an individual keyframe. Editing one of those diamonds affects only that par-
ticular keyframe's state. If you are trying to achieve a gradual fade in the opacity of your
object, you will want to adjust the other diamonds that follow the one you change.

6. Click to save your work.
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How toMove Keyframes
For all object keyframe types, you canmove individual keyframes to new locations in the timeline by using
the Object Properties window pane or the Timeline window pane. You also have the option tomove position
keyframes manually in the Frame Editor.

1. Open themovie.

2. Do one of the following:

MOVE INDIVIDUAL KEYFRAMES IN THE KEYFRAME PROPERTIES WINDOW PANE

a. In the Frame Editor, click an object that contains one or more keyframes.

b. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to
objects will also be in this view.

For action object types, click Action View. Any objects converted to action objects
will also be in this view.

c. Scroll down to the object's keyframe bar (e.g., opacity, text).

d. Click on a keyframe (diamond) within the keyframe bar.

The Keyframe Properties window pane opens.

e. In the Keyframe Properties window pane, set the Time field to a new point in time at which
the object will change to this state.
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MOVE INDIVIDUAL KEYFRAMES IN THE TIMELINE WINDOW PANE

a. In the Frame Editor, click on an object that contains one or more keyframes.

b. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to
objects will also be in this view.

For action object types, click Action View. Any objects converted to action objects
will also be in this view.

c. Scroll down to the object's keyframe bar (e.g., opacity, text).

d. Click on a keyframe (diamond) within the keyframe bar.

e. Drag the keyframe to a new location in the keyframe bar.

MOVE POSITION KEYFRAMES IN THE FRAME EDITOR

a. Click on an object that contains one or more position keyframes.

A trajectory (blue dotted path) appears near the object.

b. Click on a point (larger blue circle) within the trajectory.

c. Drag the point to a new place in the Frame Editor.

3. Click to save your work.
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How to Remove Keyframes
You can remove a single keyframemanually in the Timeline window pane. Single position keyframe tra-
jectory points can also be removed in the Frame Editor. Additionally, you remove entire keyframe type
bars.

HOW TO REMOVE INDIVIDUAL KEYFRAMES IN THE TIMELINE

1. Open themovie.

2. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to objects will
also be in this view.

For action object types, click Action View. Any objects converted to action objects will also
be in this view.

3. Scroll down to the object or effect's keyframe bar (e.g., size, position).

4. Click on a keyframe (diamond) within the keyframe bar.

5. Do one of the following:

Press theDELETE key.

Right-click on the diamond and select Delete.

6. Click to save your work.
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HOW TO REMOVE INDIVIDUAL POSITION KEYFRAMES IN THE FRAME EDITOR

1. Open themovie.

2. Click the object (in the Frame Editor or the Timeline) or clip effect (in the Timeline) that contains pos-
ition keyframes.

A blue trajectory appears in the Frame Editor.

3. Click on a circular blue point within the trajectory.

The selected point will change to yellow.

4. Do one of the following:

Press theDELETE key.

Right-click on the point and select Delete.

5. Click to save your work.
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HOW TO REMOVE ALL OBJECT KEYFRAMES AT ONCE

1. Open themovie.

2. In the Timeline window pane (View>Timeline), do one of the following:

For all standard object types, click Frame View. Any action objects converted to objects will
also be in this view.

For action object types, click Action View. Any objects converted to action objects will also
be in this view.

3. Scroll down to the object or clip effect's keyframe bar (e.g., opacity, text).

4. Click and drag your mouse over all of the keyframes in the bar.

Each keyframe diamond changes to yellow.

5. Press theDELETE key.

6. Click to save your work.
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4 Linking to External Palettes

You can link to external palettes. Youmight want to do this if you are working with a team
and need to share palettes with other teammembers. Youmight also do this if you are work-
ing on a project and have a palette that is saved to an external location that is specific to that
project.

To link to an external palette, click in the local toolbar of the Palettes window pane. In the
Open dialog, select the palette you want to import, then click Open. The imported palette
opens in the Palettes window pane.

Note: If a palette is saved to a common location, such as a network drive, any user
who links to the file canmake changes to it. When other users save their changes,
you will see the changes in your copy of Mimic. Linking to external palettes is a
good way to be sure that other members of your team always have themost cur-
rent version of the file.

However, because any user canmake changes, it is possible to easily overwrite a
file with undesired edits. Youmay want to designate one teammember tomanage
all edits to palettes to prevent unwanted changes.
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5 PropertiesWindowPane

A new window pane has been added to let you control properties for frames, objects, sounds
added to objects or frames, keyframes added to objects and clip effects, and effects added
to objects. After it is first opened, the window pane automatically switches between five dif-
ferent property types, depending on what you are clicking on in the Frame Editor or in the
Timeline.
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When you double-click a frame, the relevant properties are shown in the Frame Properties window pane.
The properties are organized intomultiple, collapsible sections.
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When you select an object in a frame or in the Timeline window pane, the relevant properties are shown in
the Object Properties window pane. The properties are organized intomultiple, collapsible sections.
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When you select an audio object in the Timeline, properties specific to the audio file are shown in the Sound
Properties window pane.
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When you select a keyframe in the Timeline, properties specific to the type of keyframe are shown in the
Keyframe Properties window pane.
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When you select an effect bar in the Timeline, properties specific to the type of effect are shown in the
Effect Properties window pane.
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6 Timeline Enhancements

Mimic's timeline has been significantly enhanced to incorporatemany new features. These
include an entirely new look, a redesigned playhead, the incorporation of keyframes, and dif-
ferent timeline views.

This chapter discusses the following:

Different Look 58
Playhead 59
Keyframes in the TimelineWindow Pane 60
Timeline Views 64
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Different Look
Themost obvious change to the Timeline window pane is that it just looks different than it did in previous
versions. This includes a different presentation for the lock and hide options, as well as object names
instead of object icons on the left side. There is also a playhead time indicator that shows you the current
position of the playhead. You can use this field to quickly jump to any point in themovie or frame.
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Playhead
There is a playhead at the top of the Timeline that you can drag tomove to a particular point in time of the
frame (or movie). As you drag this playhead, notice that the integrated preview play bar alsomoves accord-
ingly.

Also, moving the playhead to a specific place in the Timeline lets you add a keyframe at that point.
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Keyframes in the TimelineWindowPane
The introduction of keyframes affects the Timeline window pane. When a keyframe is added to an object or
clip effect, it is indicated below its respective object or effect as a keyframe type bar. Objects and clip
effects can contain multiple keyframes of different types (e.g., position, size), each of which displays on its
own bar beneath the object or effect. Each typemight havemultiple keyframes within it, indicated by dia-
mond shapes within the keyframe bar.

The Timeline's Frame View includes all regular objects and their associated keyframes. Action objects and
their associated keyframes are included in the Timeline's Action View.
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E X A M P L E

The oval represented in the image below contains several keyframe types. You can view this
object's keyframe type bars in the Frame View.
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The bubble in the image below is an action object. It contains an opacity keyframe type with four
states. You can view this object's keyframe type bars in the Action View.
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Note: The "Snap to Keyframe" option below the Timeline window pane allows you to precisely
move the playhead to a keyframe for an object. When this option is enabled and you drag the play-
head, it "snaps" like amagnet to the nearest keyframe. If you attempt to align the playhead on a
keyframewithout this option, youmight find that you are slightly off target.
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Timeline Views
The Timeline window pane has been updated. In addition to the existing view, now called the Frame View,
there are two new views in the Timeline window pane: Movie View and Action View.

MOVIE VIEW

When you click Movie View, three bars appear in the Timeline:

Top Master Frame The topmaster frame(s) applied at either themovie or frame level, if applicable.

FramesAll of the frames in themovie.

Bottom Master Frame The bottommaster frame(s) applied at either themovie or frame level, if
applicable.

Movie View works in conjunction with the live preview controls in the Frame Editor window pane. You can
move the Timeline playhead or the preview playhead to the point where you want the preview to begin play-
ing, and then press thePlay button.
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FRAME VIEW

The Frame View contains all of the objects (including image objects and audio objects), keyframe types,
and object effects currently contained on a frame. This frame shows both regular objects and any action
objects that were converted to timeline objects.
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ACTION VIEW

The Action View contains all of the objects, keyframe types, and effects currently contained on a frame for
any regular objects that were converted to action objects (e.g., a bubble being used to deliver success or
failure feedback).
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7 Video Insertion

In previous versions of Mimic, if you wanted to add an external full-motion video to an exist-
ingmovie, you had to play that video separately while recording it in Mimic in "video" mode.
Starting with this version, you can simply insert videos with aWMV orMP4 file format into a
Mimic movie. The video is added as a new frame. A film strip image on the frame indicates
that it is a video.

This chapter discusses the following:

How to Insert a Video into aMimicMovie 68
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How to Insert a Video into aMimic Movie
1. Open amovie.

2. Click on a frame. The inserted video will come after the frame you select.

3. Select the Frame ribbon. In the Insert section, select Insert Video Frame.

4. In the Open dialog, locate and double-click the video (WMV or MP4) that you want to insert.

The new frame appears after the frame you selected. The film strip image on the frame indicates
that it is a video.

You can also create a new movie from a video by selecting File>New, then selectingMovie from Media
File. Previously, you could use a similar option to createmovies from an image file. The "Movie fromMedia
File" option now allows you to createmovies from both images and videos.
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8 Video Services

You can now access and upload videos to your YouTube or Vimeo account via the Video
Services pane inMimic. This service is supported only for non-interactive HTML5 outputs
fromMimic (e.g., movies that do not contain buttons or input typing boxes designed tomake
users take action).

This Video Services window pane can be opened by selecting theView ribbon. In theSer-
vices section, select Video Services.

This chapter discusses the following:

How to Log In to YouTube 70
How to Log in to Vimeo 71
How to Upload Videos 72
How to ResumeVideo Uploads 75
How to View Uploaded Videos 75
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How to Log In to YouTube
Logging in to YouTube viaMimic requires a valid Google account.

1. Select theView ribbon. In theServices section, click Video Services.

The Video Services window pane opens.

2. In theService field, select YouTube.

3. Click Login. The YouTube Login dialog opens.

4. Click Generate new URL. The generated URLwill display in the second field.

5. Click Open in Browser. Your default browser will open with one of the following options:

If you are not signed in to a Google account, you will be prompted to sign in.

If you are signed into one or more Google accounts, you will prompted to choose an account.

6. Once you sign in or choose an account, a message appears, requesting permission for MadCap
Mimic tomanage your YouTube account.

7. Click Allow. A success code will display.

8. Click on the code and copy it.

9. Close the browser and return to theMimic YouTube Login dialog.

10. Click in the third field and paste the code.

11. Click OK.

The Video Services window pane shows that you are now logged in. The Videos section shows any
videos you previously uploaded to YouTube.
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How to Log in to Vimeo
1. Select theView ribbon. In theServices section, click Video Services.

The Video Services window pane opens.

2. In theService field, select Vimeo.

3. Click Login. The Vimeo Login dialog opens.

4. Click Generate new URL. The generated URLwill display in the second field.

5. Click Open in Browser. Your default browser will open, showing amessage. This message
requests permission for MadCapMimic to access Vimeo.

Note: If you are not already logged in to Vimeo, the Vimeo log in page will appear instead of
themessage page. Log on to Vimeo, then repeat step 6 to proceed to the next step.

6. On the Vimeomessage page, click Allow. A success code will display.

7. Click on the code and copy it.

8. Close the browser and return to theMimic Vimeo Login dialog.

9. Click in the third field and paste the code.

10. Click OK.

The Video Services window pane shows that you are now logged in. The Videos section shows any
videos you previously uploaded to Vimeo.
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How to Upload Videos
Uploading HTML5 output can be done in one of three ways:

Upload button At the bottom of the Video Services window pane, click Upload. The Add a Video
to UploadQueue dialog opens, allowing you to select the video to upload as well as add video
metadata, such as a title and category. Complete the fields and click Add.

Drag-and-dropDrag and drop the video directly onto the Video Services pane (in theVideos sec-
tion). The Add a Video to UploadQueue dialog opens with the Video field populated with your video
file name. Complete the fields and click Add.

PublishingUsers may choose to upload to a Video Service when publishing. YouTube and Vimeo
have been added to the Publishing dialog for HTML5 output.

For more information, see the online Help.

E X A M P L E S

Clicking theUpload button at the bottom of the Video Services window pane opens the Add a
Video to UploadQueue dialog.
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If you use the drag and dropmethod to upload a video, the same dialog opens with the Video field
already populated with the file you dragged in.
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The publishingmethod allows you to input the same information as the Add a Video to Upload
Queue dialog, but it is done at the time that you publish themovie.
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How to Resume Video Uploads
In the event of a network interruption, uploads will stop. “FAILED” will display beneath the video. The
uploadmay be resumed once the network is operational again by right-clicking on the failed upload and
selectingRetry/Resume Upload.

How to ViewUploaded Videos
Right-clicking on a completed upload and selectingView in Browserwill redirect you to the appropriate
YouTube/Vimeo page hosting the selected video.
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9 Visual States

Visual states can now be assigned to object actions. You can add one or more visual states
to an object. These states give objects the ability to display a different appearance when the
user performs an action, such as clicking on the object (e.g., when you click a button, it
turns blue).

You can createmultiple visual states for an object's appearance using the Visual States sec-
tion in the Object Properties window pane. You can then assign that visual state using the
object's action properties.

This chapter discusses the following:

How to Create a Visual State 82
How to Edit a Visual State 86
How to Remove a Visual State 87
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E X A M P L E

Let's say you have a rectangle that is red nomatter what the user does to the object while viewing
themovie. You would like it to change to green when the user clicks the object.

When you open theObject Properties window pane, you have the option to create a visual state for
the rectangle. The visual state you create is applicable only to the red rectangle.
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Once the visual state is created, select the default visual state (this is because the action will affect
the default state, not the visual state). Then expand theAction section in the object's properties,
and select the action you want to trigger the visual state.
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You can preview the visual state and action by using Preview Mode. Select theHome ribbon. In the
Mode section, click . Now, performing the action on the object (e.g., clicking, double-
clicking) in the Frame Editor will let you see how the visual state looks.
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How to Create a Visual State
Adding a visual state to an object is actually two sets of steps. First, you create the visual state. Then, you
apply the state to the object. In order to create a visual state, youmust get your object ready first. Once you
create the visual state, it can be applied to that object. Visual states created for one object cannot be used
on other objects.

HOW TO CREATE A VISUAL STATE

1. Open a frame that contains one or more objects.

2. Double-click an object. TheObject Properties window pane opens.

3. Expand theVisual State section.

4. Click New Visual State.

A new visual state is added to the window pane.

5. In theVisual States section, select the new visual state. This will allow you to edit its properties.

Note: If you do not select the new visual state, you will change the default properties for
the object. The selected visual state is highlighted in gray.

6. (Optional) In theName field, give the visual state a name (e.g., "red to green on click"). This will help
you identify the visual state.

7. Expand theObject Appearance section. Change the opacity and background as needed.

Note: You can add opacity states to all objects, and background color states to all objects
except polylines and image objects.

8. Expand the Text section. Change the text as needed.

9. (Optional) If you are adding a visual state to a cursor, you can add audio to the visual state. Expand
theAudio section andmake changes to the audio settings as needed. For more information, see
the online Help.
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HOW TO APPLY A VISUAL STATE TO AN OBJECT

1. In the Visual States section, select the (default) visual state.

2. Expand theAction section.

3. Click Add Action.

4. Click theEvent drop-down and select one of the following:

Click The object changes when the user clicks the object.

DoubleClick The object changes when the user double-clicks the object.

MouseEnter The object changes when the user moves themouse over the object.

MouseLeave The object changes when the user moves themouse off of the object.

MouseUp The object changes when the user clicks, and then releases, themouse button.
This allows you to create a "pressed" effect that changes back to the default settings when
themouse button is released.

Success The object changes when an input box has been answered correctly.

Failed Attempt The object changes when an input box has been answered incorrectly but
the user is still within the allowed number of failed attempts.

Failure The object changes when an input box has been answered incorrectly themax num-
ber of times allowed.

End The object changes when the frame ends. To use an end event, youmust have an
action object in your frame. You can convert an object to an action object by right-clicking it,
then selectingAdvanced>Convert to Action Object.

5. In theAction field, select Set Visual State.

6. In theShape field, select the object to which you want to apply the visual state.

(this object)When an action triggers the visual state, it affects the selected object (e.g., the
current object will change color when clicked).

[another object]When an action triggers the visual state, it affects a different object (e.g.,
when the user clicks the current object, a different object on the framewill change color).
Objects you select heremust have one or more visual states available.
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Note: Visual states are created for each object. If you want to apply a visual state to
another object, youmust first create a visual state for that object. When you select an
object from the Shape drop-down, the Visual States drop-down updates to show you the
visual states that are available for that shape.

E X A M P L E

Let's say you have two rectangles: a red one and a blue one. The red rectangle has a red to
green visual state assigned to it.

You want the red rectangle's visual state to activate when you click the blue rectangle. To do
this, you would create a "Set Visual State" action in the blue rectangle's properties. Then you
can set the shape to "Red Rectangle," and then select the "red to green" visual state, which
is associated with the red rectangle.
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When you click the blue rectangle, the red rectangle will turn green.

7. In theVisual State field, select the visual state you want to apply (e.g., when the cursor moves over
an object, it will use "Visual State 1.").

8. Click to save your work.

Note: After you create and apply a visual state, you can preview how it will look without
building themovie.
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How to Edit a Visual State
Once you have added a visual state to an object, you can edit the visual state instead of removing it and cre-
ating a new state from scratch.

1. Open amovie that contains one or more objects.

2. Double-click an object that has a visual state applied to it. Objects with visual states applied to them
have a visual states icon in the upper right corner.

TheObject Properties window pane opens.

3. Expand theVisual State section.

4. In theVisual States section, select the visual state you want to edit. This will allow you to edit its
properties.

Note: If you do not select the visual state, you will change the default properties for the
object. The selected visual state is highlighted in gray.

5. Expand theObject Appearance section. Change the opacity and background as needed.

Note: You can add opacity states to all objects, and background color states to all objects
except polylines and image objects.

6. Expand the Text section. Change the text as needed.

7. (Optional) If you are adding a visual state to a cursor, you can add audio to the visual state. Expand
theAudio section andmake changes to the audio settings as needed.

8. If necessary, make changes to the action that triggers the visual state.

9. Click to save your work.
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How to Remove a Visual State
If a visual state is no longer needed, you can remove it from an object.

1. Open amovie that contains one or more objects.

2. Double-click an object that has a visual state applied to it. Objects with visual states applied to them
have a visual states icon in the upper right corner.

TheObject Properties window pane opens.

3. Expand theVisual State section.

4. Select the visual state you want to remove, then click .

5. Click to save your work.
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10 Additional New Features

In addition to themajor features already discussed, some additional new features are being
introduced in this version.

This chapter discusses the following:

Auto-Size Objects to Fit Text 90
Clipping 92
Cursor Trajectories 96
Dictionaries—Importing 100
FIPS Compliance 102
Font Enhancements 103
Object Properties—Apply to All 107
Object Rotation 109
Preview Mode 110
RibbonsRedesigned 111
Start Page Redesigned 112
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Auto-Size Objects to Fit Text
Youwill now be able to set objects to auto-size to fit text. If you set it at themovie level, all objects will res-
ize automatically to fit text. If you set it at an object's level, only that particular object will resize as you edit
the text within it.

E X A M P L E

Let's say you add text to a rectangle shape. However, the rectangle you drew is much too small for
the text you added.

To fix this, you enableAuto-size to fit text. The rectangle automatically resizes to fit the caption. If
youmakemore changes to the text later, the rectangle will resize again to accommodate the
changes.
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HOW TO SET MOVIES TO AUTOMATICALLY RESIZE OBJECTS TO FIT TEXT

Within amovie's properties you can set all objects to auto-size to fit text. This option is perfect when you
have an existingmovie that has several objects in it, or if you have just created a new movie that will con-
tain one or more objects.

To enable this setting, open or create amovie, then selectMovie>Properties. In theMovie Properties dia-
log, select theAppearance tab, then select Auto-size All Objects to Fit Text.

HOW TO SET INDIVIDUAL OBJECTS TO AUTOMATICALLY RESIZE TO FIT TEXT

You can set each object to auto-size to fit text. To enable this setting, add an object to the frame. In the
Object Properties window pane, expand theObject Layout section and select Auto-size to fit text. This
setting will only be applied to the selected object.

Note: If Auto-size All Objects to Fit Text is set at themovie level, you will not have the option to
set auto-size at the object level.

Note: The auto-resize to fit text options do not apply to polylines, polygons, arrows, cursors,
image objects, and input boxes.
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Clipping
Applying a clippingmask to an object will allow you to hide parts of an object. Youmust have an object in
order to use clip, but you don't have to center the clip on the object. Youmight use a clippingmask if you
have an image object that you want to slowly reveal to your users.

E X A M P L E

You can associate a clip effect with any kind of object.

Let's say you want to show part of an object, then slowly widen that area to show more of the object
until the entire object is shown. In other words, you want to do a big reveal. To do this, you would
use a clip effect.

First, add an object to the frame.
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Now select Home>Effects>Clip. In this example, everything except the part of the object covered
by themask, or the red rectangle, will be "clipped" out of the frame.
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You can now add size and position keyframes to the clip effect in order to slowly widen themask
area and reveal more of the frame.

You can preview your progress as you work by pressing thePlay button in the preview bar, or by
dragging the playhead to the specific keyframe you want to check.
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In the Timeline's Frame View and Action View, the clip effect bar displays in a row directly beneath the
object it is applied to. Any keyframes applied to the clip effect are displayed in rows beneath the clip effect
bar.

Note: You can only apply one clipping effect per object.
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Cursor Trajectories
If you automatically add cursors to your recordedmovies, youmay want to edit their paths, or trajectories,
before you publish your finishedmovie. Youmight want to do this to simplify the cursor motion or to add a
motion that you did not capture in the original recording. Likewise, if you did not automatically add cursors
to your recording, you can add a cursor to your movie and create a new trajectory from scratch.

In Mimic 7, you could edit trajectories for an object (such as a cursor) by hovering over an icon next to the
cursor, then clicking and dragging the trajectory to its intended end point.

Editing the trajectory for a cursor (or another object) works differently in Mimic 8. It is accomplished by
using keyframes. The keyframes are created automatically for cursors when you record a new movie, but
you can addmore keyframes manually, just as you can for any other object.

See "Keyframes" on page 17.
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Tip:When you click on a cursor in a frame, you will see a blue line with circles representing the
beginning and end point of the trajectory. However, this trajectory is based on the upper-left corner
of the object, rather than the center of the object.

The default look for a cursor is a translucent circle with an arrow cursor in it. So if you click and
drag the blue circle representing the end of the trajectory, keep inmind that where you drop the
circle is actually the upper-left of the object when it finishes.

For example, the following cursor was created automatically after amovie was recorded. The
cursor moves so that the arrow finishes on the button that has the A and red bar under it.
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If you click the Play button at the bottom of the frame (or if you click and drag the scrubber), you
can see the actual path of the trajectory.
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Let's say you decide to adjust the trajectory so that it ends on the paint bucket button. When drag-
ging the blue circle representing the end point, make sure you drop it to the upper-left of the paint
bucket button, rather than on the button itself. Then test the results with the Play button or scrub-
ber.
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Dictionaries—Importing
You can see which dictionaries are installed on your computer by opening the Options dialog (File>Op-
tions) and selecting theSpelling tab. You can also use the Options dialog to import more dictionaries that
you have downloaded. You can download additional dictionaries from OpenOffice.org.

http://www.openoffice.org/
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In the Options dialog, you can view various information about each dictionary, including the languages avail-
able, the code for each language (e.g., ar-kw for the Arabic (Kuwait) dictionary), and a description.

Note: Dictionaries are stored in your AppDataWindows folder.
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FIPS Compliance
The Federal Information Processing Standard (FIPS) 140 is a security implementation designed for cer-
tifying cryptographic software. FIPS 140 validated software is required by the U.S. Government and reques-
ted by other prominent institutions.

Mimic uses the following cryptographic modules, which are all compliant with FIPS:

DSACryptoServiceProvider

RSACryptoServiceProvider

SHA1CryptoServiceProvider

TripleDESCryptoServiceProvider

Mimic will work if FIPS Mode is enabled inWindows.

For more information about FIPS, refer to the National Institute of Standards and Technology (NIST) FIPS
General Information site (http://www.nist.gov/itl/fipsinfo.cfm).

http://www.nist.gov/itl/fipsinfo.cfm
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Font Enhancements
Font groups and pinning have been added toMimic to enhance the way you work with fonts.

PINNING FONTS

You can pin your favorite fonts so they will appear at the top of Mimic's font lists. This makes them easier
to find later. Pinned fonts appear in a group that you can expand or collapse. This is a way to limit the list of
fonts to those that you use themost and hide from view those that you do not use.

To pin a font, expand the Font Family field in theObject ribbon. Hover over the font you want to pin and
click the little pin. It will then bemoved to the Pinned Fonts group at the top of the list.
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To unpin a font, just click the pin again and it will bemoved back to the All Fonts group at the bottom of the
list.

Themost recently pinned font is added to the bottom of the Pinned Fonts group.
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E X A M P L E

Three fonts have been added to the Pinned Fonts group. You can still see the fonts in the All Fonts
group, as well.
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FONT GROUPS

Font groups organize fonts. These groups are available in the Font Family field on the Home ribbon. They
show both pinned fonts and all system fonts. You can collapse or expand any font group. This is a way to
limit the list of fonts to those that you use themost and hide from view those that you do not use.

E X A M P L E

Let's say that you have pinned Arial, Tahoma, andGaramond. In the Font Family field on the Home
ribbon, you will see the Pinned Fonts and All Fonts groups.
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Object Properties—Apply to All
In previous versions of Mimic, you could quickly make several objects on an image look the same, taking
on the formatting settings of whichever object that you select. You could apply object properties to similar
objects (e.g., two rectangles, two ovals, two loops), but if you wanted to apply the same style to all of the
objects in the workspace, you had to select each object type individually.

In Mimic 8, you now have the option to apply properties to all of the objects in the workspace at once. You
also have the option to apply properties to similar objects (e.g., only loops, only rectangles).

Tip: Applying a single style to all objects is useful for standardizing branding. If you use a con-
sistent color palette or line style in all of your movies, you can use this feature to quickly apply a
style to Mimic's standard loops, callouts, and arrows. Then you can use the Add to Palette feature
to add these objects to a custom object palette.

E X A M P L E

In this image, there are various objects with different backgrounds, borders, and fonts. Every one of
them should look like the white "Text" circle.
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Right-click on the shape with the desired properties, then select Advanced>Make all Objects the
Same. Now, all of the objects display the same style as the white "Text" circle.



CHAPTER 10│What's NewGuide 109

Object Rotation
You can rotate an object manually by dragging the rotation handle.

1. Open themovie.

2. Click an object.

3. Click the largest blue handle, then drag the object to the desired position.
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PreviewMode
Preview mode allows you to use Frame Editor to view an action set on an object. This prevents you from
having to build movie output just to see how an action looks when it is executed. In other words, if you set a
shape to turn green when it is clicked, you can use the Preview mode to see that action as soon as you set
it up, without ever leaving Frame Editor.

HOW TO USE THE PREVIEW MODE FEATURE

1. Open amovie that has an object to which an action has been applied.

2. Select theHome ribbon. In theMode section, click Preview Mode.

3. In the Frame Editor, perform the event that causes the action to take place (e.g., click on the object,
double-click the object, move themouse over the object).
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Ribbons Redesigned
TheObject and Edit ribbons have been combined to create the Home ribbon. This ribbon has been organ-
ized so features are grouped together in amore intuitive way.

Add objects and effects, including screenshots and images, from the Insert section.

Click theObject drop-down to select an object, such as the rectangle or a button.

Click theEffects drop-down to select an object effect, such as gray scale or blur.

Note: Language options previously found onMimic 7's Edit ribbon have beenmoved toMimic 8's
Tools ribbon. Properties can be accessed from theView ribbon.
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Start Page Redesigned
The Start Page has undergone amajor redesign. This includes the following:

Getting Started This section now runs along the left edge of the Start page. Here, you can create a
new movie, or open an existing file.

Recent Files This section also runs along the left edge of the Start Page. This allows for more room
to list themost recently opened files. Files are listed in order of how recently they were opened.
Click on a file link to open that file. You can also pin files to the Recent Files list. This moves them
to the top of the list.

Help Resources This contains links to additional resources, such as the Help system, PDFs,
videos, the online community, and theMadCap blog.

News and Updates This section is at the bottom of the Start Page. It contains images and links to
events, MadCap services, and other information.
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HOW TO OPEN THE START PAGE

The Start Page automatically opens when you first launchMimic. If you close the Start Page, you can
reopen it.

Select theView ribbon. In the Tools section, select Start Page.

PINNING RECENT FILES

In the Start Page, you can pin your favorite files to keep them displayed at the top of the list.
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To pin a file, hover over any recent file and click the little pin. It will then bemoved to the top of the list.
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To unpin a file, just click the pin again and it will bemoved back to the bottom section of the list.

The pinned files are sorted in order, with the top being themost recently used.

If youmanage your recent files, removing them from the Start Page, those that are pinned are not removed.
If you want to remove a pinned file from the Start Page, you need to unpin it in order for it to be removed.
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IX PDFGuides

The following PDF guides are available for download from the online Help.

Getting Started Guide

Key Features Guide

Movie Creation Guide

Movie Editing Guide

Movie Generation Guide

Shortcuts Guide

Touring theWorkspaceGuide

What's New Guide


	CHAPTER 1 Introduction
	Summary of Major New Features
	Summary of Additional New Features

	CHAPTER 2 Frame Editor Enhancements
	Integrated Live Preview with Synchronized Audio
	Centered Frames
	Reorganized Toolbar Options

	CHAPTER 3 Keyframes
	How to Create Object Keyframes
	How to Edit Object Keyframes
	How to Move Keyframes
	How to Remove Keyframes

	CHAPTER 4 Linking to External Palettes
	CHAPTER 5 Properties Window Pane
	CHAPTER 6 Timeline Enhancements
	Different Look
	Playhead
	Keyframes in the Timeline Window Pane
	Timeline Views

	CHAPTER 7 Video Insertion
	How to Insert a Video into a Mimic Movie

	CHAPTER 8 Video Services
	How to Log In to YouTube
	How to Log in to Vimeo
	How to Upload Videos
	How to Resume Video Uploads
	How to View Uploaded Videos

	CHAPTER 9 Visual States
	How to Create a Visual State
	How to Edit a Visual State
	How to Remove a Visual State

	CHAPTER 10 Additional New Features
	Auto-Size Objects to Fit Text
	Clipping
	Cursor Trajectories
	Dictionaries—Importing
	FIPS Compliance
	Font Enhancements
	Object Properties—Apply to All
	Object Rotation
	Preview Mode
	Ribbons Redesigned
	Start Page Redesigned

	APPENDIX   PDF Guides

